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Copyright Notices and Disclaimers  
 
© Copyright 2023. Max Analytical Technologies, part of Thermo Fisher Scientific. All right reserved. 
 
Max Analytical Technologies and Thermo Fisher Scientific are registered trademarks of Thermo Fisher 
Scientific Inc. in the United States. 
 
All rights reserved. No part of this work may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, including photocopying and recording, or by an information storage or retrieval 
system, except as may be expressly permitted in writing by Max Analytical Technologies, part of Thermo 
Fisher Scientific. 

 
EMS-10™, EMS-10S™, EMS-10X™, ASC-10™, ASC-10-ST™, MAX-OXT™, MAX-iR™, MAX Acquisition™ and MAX-

Analytics™ are trademarks of Max Analytical Technologies. 

Microsoft®, Excel®, and Windows® are registered trademarks of the Microsoft Corporation. 

NIST Data: This product includes portions of the NIST Standard Reference Database 35 - NIST/EPA GAS-PHASE 

INFRARED DATABASE JCAMP FORMAT and is protected by US copyright law: NIST Standard Reference Data 

(SRD); © Copyright 2013 by the U.S. Secretary of Commerce on behalf of the United States of America. All 

rights reserved.  

NIST makes NO EXPRESS OF IMPLIED WARRANTY AS TO ANY MATTER, INCLUDING NO WARRANTY OF 

MERCHANTABILITY AND NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE. THE DATABASE IS 

EXPRESSLY MADE AVAILABLE ON AN “AS IS” BASIS. This database is not for resale or distribution by customer.  

About this Manual 
The MAX-iR is intended for use in non-hazardous, safe, or general-purpose classification areas. This operational 

manual provides instructions for setup and best practices in using the MAX-iR. By following the sections 

outlined below, you will cover all the basic installation, setup, and qualification procedures required to operate 

the MAX-iR. 

Contact Information and Technical Support 
Safe and reliable operation of this equipment is conditional on all installation, operation and maintenance 

procedures being carried out in accordance with the appropriate manuals, by personnel having appropriate 

qualifications, experience, and training. Failure to observe the requirements of the manual may result in the 

user being held responsible for the consequences and may invalidate any warranty. 

For application or technical support: 

1. Dial 1-800-532-4752 
2. Select “option 2” for Unity Lab Services technical support. 
3. For your instrument type, select “option 6” for Molecular, Vibrational Spectroscopy Based 

Spectrometers. 

4. Alternatively, you can e-mail for support to: 

  us.techsupport.analyze@thermofisher.com 
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1 MAX-iR Safety 

This chapter identifies potentially hazardous conditions which may be present during normal operation of the 

MAX-iR. This system is intended for use in non-hazardous, safe, or general-purpose area classifications. The 

MAX-iR is not certified for use in a hazardous area. 

System Training and Support 

Thermo Fisher Scientific offers both on-site and web-based training programs for companies interested in 

educating their employees on the MAX-iR operation. In addition, advanced maintenance, repair, and 

applications services are available through the MAX-Advantage Service & Support Contract.  

To schedule a training session or set up a support contract, please contact Technical Support (see Contact 

Information and Technical Support). 

Equipment Intended Use 

The equipment is intended for indoor use in an ordinary location.  The equipment should be kept dry and 

should be operated only in a non-explosive and non-toxic environment.   

The equipment is intended for the analysis of non-toxic, non-caustic and diluted combustible gases (gases 

below 25% of their lower explosive limit). 

See the installation section of this manual for required operating temperature, power requirements, and other 

specific requirements for proper installation and operation of the equipment. 

Hazard Notices Used in this Manual 

The equipment poses potential hazards during installation, operation, and service.  In this manual you will find 

four levels of safety precautions and important notices that conform to ANSI Z535 and ISO 3864.  These hazard 

notices identify the hazard, explain how to avoid the hazard, and identify probable consequences of not 

avoiding the hazard. These notations are provided primarily in the procedural sections and are intended to 

complement the ANSI and/or ISO safety labels physically located on the equipment. 

 
Avoid hazard. Danger notifications indicate a hazardous situation which, if not avoided, will result in serious 
injury or death.  The hazard is imminent. 

 
Avoid hazard. Warning notifications indicate a hazardous situation which, if not avoided, could result in 
serious injury or death.  The hazard is possible. 

 
Avoid hazard. Caution notifications indicate a hazardous situation which, if not avoided, could result in a 
moderate or minor injury and/or equipment damage. 
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Notice notifications provide information to follow to avoid damaging system hardware or losing data. 

 

Symbols Used on the Equipment 

 

On (Power)  
IEC 60417, No 5007 

 

Off (Supply) 
IEC 60417, No 5008 

 

Protective Earth Terminal 
IEC 60417, No 5019 

 

Fuse 
IEC 60417, No 5016 

 

General waring, refer to manual for further instructions 
ISO 7010, W001 

 

Warning, risk of electric shock 
ISO 7010, W012 

 

Warning, hot surface. 
ISO 7010, W0017 

 

Equipment is compliant with requirements for the European Union.  See Declaration of 
Conformity for further details on Directives and Standards used for compliance. 

 

Equipment is compliant with requirements for Great Britain.  See Declaration of 
Conformity for further details on Directives and Standards used for compliance. 

   

The equipment should not be discarded as unsorted waste but must be sent to separate 
collection facilities for recovery and recycling. 
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General Safety Precautions 

This section lists some of the hazards that could be encountered with the equipment.  More specific hazards 

are listed throughout the manual in the relevant sections. 

 
Read the Manual before Operation: All operators should read and understand this manual before using 
the equipment.  It is essential for all personnel to understand the operation procedures and how to avoid 
potential hazards associated with the use of the equipment. 

 
Only trained and experienced service persons should perform maintenance and repairs.  Contact Max 
Analytical for service and/or training. 

 
Do not substitute parts or modify equipment.  Do not install substitute parts or perform any modifications 
to the hardware that have not been authorized by Max Analytical. 

 
Use the proper power cord.  Only use a detachable power cord that is rated for the voltage and current 
specified on the equipment nameplate.  The power cord should have a minimum cross-sectional area of 
0.75 mm2 (18AWG). The power cord should be certified by an appropriately qualified agency such as UL, 
VDE, or Semko. 

 
Explosion Hazard: The equipment will expose sample gas to heated surfaces and is intended for the analysis 
of non- flammable gas mixtures only.  The concentration of any flammable gases in the sample stream 
should be less than 25% of the lower explosive limit (LEL).  Failure to comply may result in injury or death. 

 
Inhalation Hazard: Be sure that any sample exhaust ports are properly connected to a safe vent location to 
prevent exposure to potentially dangerous gas mixtures.  Inhalation of certain gases may cause headache, 
dizziness, nausea, bodily irritation, irregular heartbeat, or death. 

 
Shock Hazard: The system enclosure contains high voltage.  The system must be de-energized during all 
maintenance and service operations. Failure to comply could result in injury or death.   

 
Compressed Gas Hazard: The equipment requires nitrogen for purge and calibration gas cylinders for 
analysis.  Check for leaks before turning on any gas supply and wear safety glasses to prevent injury.  Failure 
to comply could result in injury.   

 
Burn Hazard: The equipment contains heated components inside the enclosure and hot fittings on the back 
panel.  Disconnect power and allow the equipment to cool before servicing and avoid touching the fittings 
on the back of the equipment.  Failure to comply could result in injury. 
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Equipment Damage and Ergonomic Hazard: The MAX-iR weighs approximately 75 lbs (34 kg), exceeding 
the recommended lifting weight (RLW) for one person. Improperly lifting the instrument may result in back 
injuries or the system being dropped or damaged. To avoid injury and equipment damage, exercise the 
proper safety precautions and always use at least two people to lift the equipment. 

 
Follow Appropriate Procedures for Safe Handling of Chemicals: When handling/using chemicals for 
preparation or use within the equipment, all applicable local and national laboratory safety practices must 
be followed. This would include, but is not limited to, following general laboratory and chemical handling 
safety practices, use of all relevant engineering controls such as ventilation hoods, and appropriate 
selection and use of Personal Protective Equipment (PPE). Failure to adhere to laboratory safety practices 
could lead to injury or death. 
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2 MAX-iR Overview   
 

MAX-iR FTIR Gas Analyzer 

The MAX-iR is a Fourier-Transform Infrared (FTIR) based gas analyzer with a wide dynamic range, capable of 

measuring impurities in bulk gas from ppt to percent levels. The MAX-iR analyzer measures gases by absorption 

spectroscopy and for a given temperature and pressure, a compound’s absorption is constant, meaning the 

FTIR calibration curve is transferable from instrument-to-instrument and should be valid for the life of the 

instrument.  

 

The MAX-iR was specifically designed to perform with minimal 

operator requirements and is composed of three main sections: 

(1) an FTIR spectrometer using moisture impervious ZnSe optics 

and a solid-state (VCSEL) laser for timing, (2) a temperature-

regulated 0.456L multiple pass gas cell with 9.86m path length 

which can operate under pressures from 1 to 5 atmospheres, and 

(3) an infrared detector. 

The MAX-iR does not require liquid nitrogen to cool any of the 

three detector versions available (DTGS, MCT, or InAs) depending 

upon the application. 

Optional MAX StarBoost™ Technology 

StarBoost is a patented, signal-enhancement technology that dramatically increases sensitivity, linearity and 

dynamic range over narrow spectral bands of interest. This technology allows for single digit ppbv detection of 

hazardous air pollutants (HAPs) in real-time.  

The StarBoost hardware enhancement utilizes an optimized detector and optical filter to achieve very low-level 

detection limits for compounds like ethylene oxide, formaldehyde or BTEX. The technology is an optional 

supplement to the base MAX-iR for trace detection, CEM, and fugitive emissions applications. This technology 

enhancement follows the same Quality Assurance (QA) protocol outlined in standard extractive FTIR test 

methods, including US EPA Method 320 and ASTM D-6348. 

The software can also incorporate an Auto-reference algorithm that eliminates baseline drift, when very high 

signal-to-noise data are being acquired and analyzed.  
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Part Numbers and Configurations 

TABLE 1. MAX-IR CONFIGURATIONS 

Product Description 
Part 
Number 

Detector StarBoost 
Pressure 
Transducer 

Windows 
Std. O-
Rings 

MAX-iR, DTGS, Low 
Pressure, 120V 

101-0343 DTGS None 1atm 
KBr 
(MgF2) 

Viton 

MAX-iR, DTGS, Low 
Pressure, 240V 

101-0447 DTGS None 1atm 
KBr 
(MgF2) 

Viton 

MAX-iR, DTGS, High 
Pressure, 120V 

101-0344 DTGS None 5atm 
KBr 
(MgF2) 

Viton 

MAX-iR, DTGS, High 
Pressure, 240V 

101-0448 DTGS None 5atm 
KBr 
(MgF2) 

Viton 

MAX-iR SB, MCT, LP3400, 
Gas Purity, 120V 

101-0416 MCT 
Long Pass Filter 
(3400cm-1) 

1atm CaF2 Metal 

MAX-iR SB, MCT, LP3400, 
Gas Purity, 240V 

101-0450 MCT 
Long Pass Filter 
(3400cm-1) 

1atm CaF2 Metal 

MAX-iR SB, MCT, LP3400,  

Low Pressure, 120V 
101-0429 MCT 

Long Pass Filter 
(3400cm-1) 

1atm CaF2 Viton 

MAX-iR SB, MCT, LP3400,  

Low Pressure, 240V 
101-0451 MCT 

Long Pass Filter 
(3400cm-1) 

1atm CaF2 Viton 
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Overview of MAX Acquisition Software 

The MAX Acquisition software is used to configure an Acquisition Method specific to the site’s application 

needs. It provides all the End User controls for data acquisition tasks including starting, pausing, or stopping a 

data acquisition routine, displaying any potential alarm states as well as run-time concentration values from a 

single user interface. Once configured, the Acquisition Method has the capability to automatically control the 

operation of the MAX-iR as well as any other instrumentation and equipment defined within the selected 

configuration. Software can also be set-up to directly interface with a plant's DCS or PLC or a laboratory LIMs 

system if the plant uses MODBUS communication. For Analog communication, a FIM (Factory Integration 

Module) is required to interface with the plant's data system. The FIM can be purchased from MAX Analytical 

Technologies as an accessory.  

While the end user can create and make changes to the Acquisition Method, this service is also provided by 

Max Analytical Technologies who can develop a custom method fit for purpose. Please contact the Max 

Application team at +1 860-386-6878 or call your local Thermo Fisher sales representative. 
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3 MAX-iR Facility Requirements & Installation 

This chapter describes how to prepare a site for installation as well as procedures for uncrating and initial setup 

of the MAX-iR. Included in this chapter are guidelines for selecting sample and calibration gas lines and filter 

materials. 

 
Do not attempt to install, commission, maintain or use the MAX-iR FTIR unless you have been trained or are an 
experienced instrument technician. 

 
The MAX-iR is not ATEX certified and is not suitable for installation in hazardous areas. 

 

MAX-iR Site Requirements 

Facilities Requirements 

TABLE 2. MAX-IR FACILITIES REQUIREMENTS 

Component Requirement Cords/Tubing Fittings/Connection 

Power (NA 120V) 120 VAC, 50/60Hz, 3.7A 10A North American Power 

Cord, 5-ft (1.5-meter) 

IEC 320-C13 to 

NEMA 5-15 Plug 

Power (Europe) 208-240VAC, 50/60Hz, 

2A 

10A Euro Power Cord, 

1.5-meter (5-ft) 

IEC 320-C13 to 

Euro CEE7/7 Plug 

Purge Gas Nitrogen, N3.0 or Better, 

20psig 
¼” High Purity HDPE 

¼” Swagelok 

(¼” fitting Provided) 

Calibration Gas 

Requirements 

Calibration gas in a 

balance of N2, 20psig 
¼” High Purity HDPE 

¼” Swagelok 

 

Zero Gas Requirements Nitrogen, N4.0 or Better, 

20psig  
¼” High Purity HDPE 

¼” Swagelok 

 

Computer Interface 

Connections 

Ethernet Communication 

to Computer 
CAT5E/6 Patch Cord RJ45 Connector 

Serial Communications 

to Computer 

USB Type A-B Cord, 3-ft 

(1-meter) 
USB Type B Connector 
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Environmental Requirements 

The system is suitable for indoor use in a dry location only. The equipment is cooled by an internal ventilation 

fan, so leave at least a 6-inch (15-cm) clearance around the FTIR to allow suitable airflow through the enclosure. 

TABLE 3. MAX-IR ENVIRONMENTAL REQUIREMENTS 

Component Requirement 

Operating 
Temperature Range 

20 to 30°C 

68 to 86°F 

Humidity 10-90% relative humidity, non-condensing 

Warm up time Typically, 1 hours from 20°C to 191°C 

Ingress Protection The system is designed to meet IP20 

Overvoltage Category 
Category II - Equipment with plug and socket connector or fixed connection supplied 
from the Table 4. Gas Sampling Requirements electrical system of a building. 

Mains supply voltage 
fluctuations 

±5% 

 

Sample and Exhaust Requirements 

TABLE 5. MAX-IR GAS AND EXHAUST REQUIREMENTS 

Component Requirement 

Sample Gas Temperature 35°C, 150°C or 191°C are standard 

Sample In Gas Line For monitoring heated sources such as combustion stacks or engines, a dual core 

heated ¼” sample line with ¼” HDPE calibration line is required; customer 

supplied. Low temperature (35C) non-condensing samples require ¼" HDPE. 

Sample Gas Flow Rate Sample 1 to 5 LPM (20 psig). 

Purge Gas Flow Rate 0.2 to 0.5 LPM (200 to 500 sccm). In cases where detection limits on the order of 

ppm are desired, nitrogen purge can be applied and then sealed off. 

Purge Gas Condition UHP grade (N3.0), oil and particulate free, non-condensing, filtered to 0.1µm 

Exhaust Gas Vent Connect the outlet of the MAX-iR to a separate atmospheric vent, free from back-

pressure. 
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IT Requirements 

System Control 

The MAX-iR is controlled by connecting the FTIR to a computer (which is running the MAX Acquisition software) 

via a standard Ethernet connection.  This connection is set within Windows to the IPv4 address 192.168.254.11, 

which will directly connect to the MAX-iR. In addition, a USB serial interface is needed between the operational 

computer and the MAX-iR in order to monitor the gas cell temperature and pressure. 

Max Analytical Remote Support 

The MAX-iR FTIR can be monitored and controlled remotely through the commercially installed remote desktop 

software, such as TeamViewer.  To engage remote Technical Support, the facility must provide temporary 

Internet access, and this generally requires IT support from the customer side to grant access. 

Workspace Installation Requirements 

Make sure that the unit placement allows for proper ventilation to prevent any accumulation of gases within 

the enclosure and maintain proper internal operating temperatures including airflow through the vents on the 

side of the analyzer. 

TABLE 6. MAX-IR WORKSPACE DIMENSIONS 

MAX-iR 
Dimension 
(W x D x H) 

Min. Clearance 
(Front, Rear, Left/Right) 

Weight (est.) 

US Measurements 19.0 x 25.7 x 8.75 in 6in, 12in, 6in 75 lbs. 

European Measurements 482.7 x 654 x 222.3 mm 152mm, 304mm, 152mm 34 kg 

 

 
Lifting Hazard: The weight of the MAX-iR is approximately 75lbs (34kg). Do not attempt to lift the unit alone as 
severe damage to muscles and ligaments could occur. 
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Installation Drawings and Figures 

MAX-iR Front View 

 

MAX-iR Rear View 
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MAX-iR Side View 

 

MAX-iR Top View 
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Unpacking the MAX-iR 

The MAX-iR is carefully packed to reach its destination in excellent condition. When the instrument is received, 

inspect the packaging for any defects and check any shock and tilt indicators to be certain that damage has not 

occurred during shipment. If you find any damage, please notify Technical Support immediately (see Contact 

Information and Technical Support). You must obtain a Return Material Authorization (RMA) number from 

Thermo Fisher Scientific before shipping any component back to the factory. 

Save the original packing material as this will be required to return the system to Thermo Fisher Scientific if a 

return is necessary. The use of unsuitable packing material during shipping will void the instrument warranty.  

 
Equipment Damage: Allow 24 hours for the instrument to reach room temperature before unpacking. Unpacking 
the MAX-iR when it is cold may result in damaging condensation on the electronic components and/or optics. 

 

Storage 

If you must store the MAX-iR before installation, ensure that the instrument is stored in its original packing in 

an area that is both humidity-controlled and temperature-controlled to the following conditions: 

TABLE 7. LONG TERM STORAGE REQUIREMENTS 

Condition Requirements 

Temperature +4 to +38°C (39 to 100°F) 

Humidity 20-80% non-condensing 

Packaging Original packaging, must stay closed 

 

 
Equipment Damage: Storing the MAX-iR in an environment outside of these specifications may cause equipment 
damage which is not covered under warranty. 
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Hardware Installation 

The MAX-iR is designed to be installed in a climate controlled, sheltered location only and can be mounted in 

a standard 19.5-inch rack or placed on a suitable table or shelf.  When installing the MAX-iR in a rack, it is 

recommended to use a shelf to support the weight while using four rack screws to secure the MAX-iR in the 

rack.  Clearance of at least 6 inches should be maintained on the sides of the enclosure and clearance of at 

least 12 inches should be maintained at the back to provide suitable ventilation. 

Use the two handles on the front and the handle on the rear to lift carefully into the installation position. 

 

 

 
Lifting Hazard: The weight of the MAX-iR is approximately 75lbs (34kg). Do not attempt to lift the unit alone as 
severe damage to muscles and ligaments could occur. 
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Power and Gas Connections 

Power Connections 

Using the power cable provided, connect the MAX-iR to a suitable power outlet. Be sure to use an outlet with 

the voltage required for the MAX-iR as stated on the product label on the rear panel. (See Facilities 

Requirements). 

The power cords provided are rated for 10A service and have appropriate safety certifications for the local 

region.  Be sure any replacement cord has the same or higher current rating and appropriate local safety 

certifications. For regions other than North America and Europe you must check the rating on the label before 

applying power. 
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Gas Stream Connections 

The figure below describes the gas connections that must be made to the MAX-iR. All connections are ¼” 

Swagelok. 

If the MAX-iR is not purchased with an ASC-10 Automated Sampling Console, then the user must install a 1.0, 

5.0 or 10.0 LPM flow controller (rotameter or mass flow controller) on the Sample Inlet port to control the flow 

rate going through the MAX-iR gas cell, which are typically in the range of 1-5 SLPM. 

A 1.0 LPM flow controller (rotameter or mass flow controller) is recommended to control the N2 gas flow rate 

going to the MAX-iR optics through the Purge In port.  The recommended N2 purge gas flow rate is 0.2 – 0.5 

SLPM at the maximum N2 gas supply pressure is 20 PSIG. If the application does not require low level (ppbv) 

detection limits, the purge ports can be sealed after running a N2 purge. 

Connect a line to the Sample Out port and channel the flow to an appropriate exhaust vent. The line should be 

short as possible, to avoid any back pressure on the system, and should be installed so the flow is channeled 

downwards, to avoid any moisture condensation buildup within the line. The exhaust line is typically 3/8" HDPE 

and 10–30ft in length. 

 

 

 
Equipment Damage: To avoid damage to the MAX-iR electronics due to moisture condensation, wait at least 
1 hour after powering up the system before connecting the nitrogen purge to the instrument. Wait until the 
gas cell is at temperature until connecting sample gas to the Sample Inlet. 

 
Inhalation Hazard:  If the MAX-iR is to be installed in a shelter that does not have an active air flow 
replacement mechanism, then you must also connect an exhaust gas line from the N2 Purge Outlet port to 
an appropriate exhaust vent to avoid the buildup of N2 gas within the room (if N2 purge is being employed). 

 

  



 

  Page 22 

 

Computer Setup 

For customers setting up a computer for the first time, complete the network configuration and software 

installation instructions outlined below. If the computer was provided and/or configured by Thermo Fisher 

Scientific, proceed directly to Getting Started with MAX-Acquisition. 

I/O Connections 

The diagram below shows the Ethernet and USB connection locations on the back of the MAX-iR. Connect the 

ethernet cable provided with the analyzer from the LAN port on the back of the FTIR to an Ethernet port on 

the control computer. This ethernet network must remain isolated and should not be connected to a local area 

network. Connect the USB cable provided with the analyzer from the USB port on the back of the FTIR to one 

of the USB ports on the control computer. 

    

 

Network Configuration 

After the ethernet and serial cables are connected to the control PC, configure the PC’s Network Connections 

according to the table below. 

TABLE 8. MAX-IR NETWORK CONFIGURATION 

Component IPv4 Address Subnet Mask 

Ethernet on PC to MAX-iR 192.168.254.11 255.255.255.0 
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4 Software Installation and Setup 

This chapter reviews the different types of files used in the Max Analytical software package and how they are 

incorporated into gas analysis methods. 

Installing MAX Analytical Software on the Control PC 

License Key 

Two USB-bound license keys are provided with the purchase of one MAX-iR. Each key includes a copy of the 

software package and the standard MAX files required for analyzing data. To install the software, the key MUST 

be inserted into the USB port of the PC connected to the instrument.  The license limits the use of the full 

software package to one user on one computer at a time. All software should be installed in a Windows Pro 10 

(or higher) Operating System. 

 

Software Installation 

1. Download the two installers to the Control PC 

o MAX Analytical Installer  

o MAX Analytical Quant Library Installer  

2. Run the MAX Analytical Installer 

o Make sure the License USB Key is installed on the Control PC 

o Open the MAX Analytical Installer by double clicking on the EXE File. 

o When prompted for the license key, press the Refresh button to upload the license 

information from the USB to the PC. Then press the Next button

 
o Follow the prompts to finish installing the MAX-Acquisition software 

3. Run the MAX Analytical Quant Library Installer 

o Open the MAX Analytical Quant Library Installer by double clicking on the EXE File. 

o When prompted for the license key, press the Refresh button to upload the license 

information from the USB to the PC. Then press the Next button 

o Follow the prompts to finish installing the MAX-Acquisition software 
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Getting Started with MAX-Acquisition 

1. Launch the MAX-Acquisition software from the desktop icon ( ). 

o Make sure that the MAX-iR is powered up and is detected by the software 

o Press the Select button for the Instrument Configuration set up on the Getting Started pop up 

panel.  

 

2. Select the Instrument Configuration.  

o A separate window will pop up with the list of default Product Configurations. Click to highlight 
the MAX-iR and press the Select button at the bottom.   

 
o The Getting Started pop up should now have MAX-iR listed next to Instrument Configuration.  
o The Default method called MAX-iR will be listed next to Instrument Method.   
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3. In the Getting Started window, press Continue. These settings can be changed later.  

Once the application is configured from the Getting Started window, follow the instructions for  

Connecting to MAX-iR for the first time. 
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MAX-iR Hardware Connection 

Connecting to MAX-iR for the first time 

To connect to the MAX-iR for the first time, follow the instructions below. 

1. Edit the MAX-iR Product Configuration. 

o From the main MAX Acquisition menu, Go to Edit > Product Configuration to open the Product 

Configuration List Editor. 

o Click to highlight the MAX-IR configuration, then click Edit ( ). 

 

2. Search for the MAX-iR spectrometer instance. 

o Click on the MAX FTIR spectrometer module in the Product Configuration window. Under 

Spectrometer Instance, click Search… 

 

o The software will search the spectrometer MAC address. Once found, click to highlight the 

MAC address. 

 

o Click OK to return to the Product Configuration editor. 

 

3. Search for the pressure and temperature sensor COM port. 

o Click on the MAX FTIR pressure and temperature sensor module in the Product Configuration 

window. Next to COM Port, click the Search button. 
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o Once the software detects the pressure and temperature sensor, a pop-up will identify COM 

port. Click OK to select the COM port. 

 

4. Once the spectrometer and pressure and temperature sensors are detected, click OK to return to the 

main MAX-Acquisition window. 

o If the spectrometer and/or temperature and pressure sensors were not detected, proceed to 

Chapter 10 Troubleshooting. 
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Checking the MAX-iR Hardware Connection Status 

The hardware connection status will appear in the lower left corner of the window. The status will say 

“Connecting” as the computer initiates communications with the hardware any time the software is launched 

or a new Acquisition Method or Product Configuration is selected. After a moment, the status should read 

“Idle” if the computer can connect to the MAX-iR. Definitions of all status indicators are listed below:  

TABLE 9. HARDWARE CONNECTION STATUS INDICATORS 

Status Function 

Idle The software can connect to the hardware and is ready to acquire data. 

Offline There is a communication issue between the software and hardware.  

Acquiring The software is in runtime mode, collecting spectral data and storing it to the PC. 

Paused The data acquisition has been manually paused. 

Error Recovery Acquisition was interrupted by a hardware connectivity issue.  

Waiting on 

Preconditions 

One or more devices must reach a precondition (mainly a temperature setpoint). 

Acquisition will automatically begin once the precondition is met.  

 

If the software cannot connect to the hardware, a pop-up will indicate that the Acquisition Status of the MAX-

iR is offline and failed to connect, and the User Interface will display ‘ Offline’ status in the lower left corner.   

 

Close the pop-up panel and check that all Ethernet and USB connections are connected to the Control PC. Refer 
to Chapter 10 Troubleshooting for instructions. 
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Installing Methods on the Control PC 

Overview of Required Files 

There are three types of files that make up the framework of method development for every application: 

1. Product Configuration 

2. Acquisition Method 

3. Quant Method  

These files are application-specific.  

Standard product configurations and methods are embedded in the MAX Analytical Quant Library installer. 

They are locally stored as Archives (ZIP) in C:\MAX Data\Quant Library\Archives. 

For custom method development, please reach out to your local Thermo Fisher Scientific sales representative.  

Product Configuration 

The Product Configuration outlines the hardware components connected to the computer. For the MAX-iR it 

establishes connections to spectrometer and temperature/pressure controller. Additional devices may include 

the Data Recorder and Modbus Slave Publishing. 

Method Scheduling (optional) is set up within the Product Configuration Editor. Any Acquisition Method can be 

scheduled to run daily, weekly, monthly, or while the system is Idle.   

In this table, the user can also choose which methods are displayed on the control panel in Monitor View. 

Acquisition Method 

The Acquisition Method is where the FTIR setpoints and parameters are specified. It also contains the 

Workflow, which defines a programmed sampling sequence with worksteps and timing.  A Workflow can be 

set up for performing Daily QA checks as well as for routine gas monitoring.  

Quant Method 

The Quant Method contains the MAX-iR calibration files (Reference Profiles) and analysis parameters for each 

compound. Optional Gas Alarms and Algebraics are setup in the Quant Method. 

Measurement Standards (Optional) 

Measurement Standards define thresholds that can be shared between quant methods. They are used to 

quickly alter a group of alarm ranges to meet different quality metrics. You can reference these Measurement 

Standards when creating alarms. These standards are critical for modifying alarms during the replacement of 

CTS and Calibration gas cylinders.  

Measurement standards are accessed from the top toolbar at Edit > Measurement Standards.  

The user can review or modify the Linked Standard and the list of criteria for individual gas standards. Upper 

and lower thresholds as well as non-detect (ND) limits can be specified by the user.  
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Installing Methods using the Archive Extraction Tool 

If custom methods were provided by Thermo Fisher Scientific in the form of an Archive (ZIP) file, follow the 
instructions below to extract the files onto the control PC and load the methods in MAX Acquisition.  
 

 
Do NOT extract the Archive file in Windows File Explorer. Leave it in the original format as a ‘*.zip’ and follow the instructions 
below to extract the files in the Max Analytical software. The Max Analytical software requires this format to properly upload 
all the information and files.  

 
1. Load the (*.zip) file that contains the custom method(s). 

o In the main viewing panel go to the top toolbar and select Tools > Extract Archive.  

 
o A window will open titled Archive Extraction Options. 

 
2. Select the appropriate extraction options. 

o Press the top Browse button to open Windows File Explorer.  
o Navigate to the save location of the Archive file (*.zip).   
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3. Select the file and click Open to return to the Archive Extraction Options window.  

 
The default save location for the extracted files is C:\MAX Data. It is not recommended to change the Extract 
To file path.  

4. Check the boxes as they appear in the figure below.  This will extract all potential Max Analytical files 

contained within the archive folder. 

o Please note that the required checked boxes may be different if only certain files are needed, 

or if existing files need to be overwritten.  

 

5. Click OK at the bottom of the Archive Extraction Options window.  

o A pop-up panel will list the files that were Extracted or Skipped. It also states the total number 

of files extracted. Select Close to return to the main screen.   

 

o If multiple Acquisition Methods were extracted, please continue to the next section for 

instructions on selecting a method from the list of available methods. 
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  5 MAX-Acquisition Software Overview and Features 

This chapter will cover the functions of MAX-Acquisition and the tools needed for general operation.  

Software Display Views 

There are three viewing modes in MAX Acquisition: Monitor View, Detailed View, and Diagnostic View.  

TABLE 10. MAX-ACQUISITION DISPLAY OPTIONS 

View Function 

Monitor View A simplified display that allows for starting/stopping data acquisition, monitoring alarms, and 

viewing historical reports. 

Detailed View Displays the real-time instrumental settings, the concentration results for each gas in the 

method, and the sample spectrum.  

Diagnostic View Used for performing routine, diagnostic checks on the MAX-iR. Allows the user to set the 

laser frequency and monitor the resolution and SNR. 

 

The mode can be changed by clicking View on the top tool bar and selecting one of the three options from the 

dropdown menu. The current viewing mode is denoted with a checkmark. 
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Monitor View 

Monitor View enables the user to readily check the MAX-iR hardware health. It also displays any application-

specific gas alarms and has controls for starting and stopping data acquisition.  

 

Acquisition Method Control Panel 

The Acquisition Method Control Panel lists the available Acquisition Methods for the active Product 

Configuration. Each method can be run instantaneously or paused by clicking on its respective button.  

Additionally, the operator can begin collecting data by pressing the “Start Acquisition” button in the Actions 

panel on the lower left of the window. When acquiring data, this same button will turn green and say, “Stop 

Acquisition.” Clicking this button will stop the run. If the scheduling tool is implemented, this button will say 

“Start Scheduler” and “Stop Scheduler.” 

The Reports button on the bottom left allows the user to view historical reports in an HTML format. All raw 

spectra are stored indefinitely on the computer harddrive for validation. 

Alarm Panel 

The Alarm Panel section has two tabs, the Alarm Monitor and Alarm History. The Alarm Monitor tab displays 

the hardware health statuses and gas alarms. The Alarm History panel is a log of all alarms that occurred within 

a current run, as well as their timestamps and current alarm state.  

User defined critical alarms may be programmed to latch so that when they trip, an operator must click the 

“Clear Alarms” button.  

 

Runtime 
Concentration 

MONITOR VIEW 

Alarm Panel 

Acquisition 
Method 
Control 
Panel 
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Runtime Concentration  

The bottom panel in Monitor View displays a real-time Concentration plot of the actively selected gas 

component. This plot updates during acquisition.   

If there are gas alarms in the active method, the runtime profile plot will track the item selected from the Gas 

Alarm list.  
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Detailed View 

Detailed View displays all acquisition controls and spectral information and is intended for advanced users. This 

viewing mode is arranged into five main panels: Runtime UI, Gas List, Concentration Profile, R2 Spectral Analysis, 

and the Spectrum Display. The figure below is an example of Detailed View.  

 

  

DETAILED VIEW 

Spectral Data & 
Concentration 

Runtime UI 

Gas List 
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Runtime UI Panel 

The Runtime UI displays metrics and controls relevant to the active run. The user can start, stop, and pause 

data acquisition from the Runtime UI. This panel also shows the current instrumental conditions. For the MAX-

iR, the Runtime UI will display the following tabs: Info, Workflow, and MAX FTIR. Additional tabs may be visible 

if subcomponents are added to the system.  

TABLE 11. RUNTIME UI TOOLS AND ICONS 

TAB / 
ICON 

Name Function 

 
Start Acquisition 

Initiates data collection. Begins a new run if started from the “Idle” state. 

Resumes acquisition if a run is paused. 

 
Pause Acquisition Pauses data acquisition during an active run.  

 
Stop Acquisition Stops data acquisition and ends a run.  

 

 

Previous/Next 

Steps 

Changes the current work step. Can manually advance to the next step in 

the sequence or backtrack to repeat a previous step. 

 
Info 

Displays FTIR spectral file name, timestamp, pressure, temperature, and 

Quantification Method options. 

 
Workflow 

Displays the active Work Step and file prefix of the pending spectrum. 

Allows the user to edit the file prefix and spectral averaging. 

 
MAX FTIR 

Displays the real-time gas cell temperature, pressure, and signal. Displays 

the detector temperature (StarBoost only). A progress bar shows the 

number of scans until the next spectrum is published. 
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Gas List 

The Gas List tabulates the analytical results of the current run for all the compounds in the Quant Method.  

• The results update after each spectrum is collected.  

• Each compound is listed in the Gas ID column and sorted alphabetically.  

• The Value column displays the concentration results. 

• The units and significant figures can be modified in the Quant Method.  

• the SD column publishes the standard deviation of the concentration.  

• The colorful squares convey the gas color in the Concentration Overlay.  

• The actively selected gas is highlighted in blue.  

 

 

Data quality indicators for each compound are displayed in the first column. An asterisk next to the ratings 

indicates a suspected quality issue with the gas analysis. 

 Good    Moderate   Low  

Near Detection Limit No Match   Below Detection Limit 
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Concentration Profile Plot 

The plot at the top of the screen displays the Concentration profile over time for the selected Gas ID.  

To display a plot that includes every gas, click on the Concentration Overlay icon ( )  in the top tool bar.  

On the graph, the bold line represents the values of the gas selected in the gas list, and the lighter lines 

represent the other individual gas measurements. The color legend for each component is on the right side of 

the gas list. 

 

R2 Spectral Analysis  

The plot in the middle displays the R2 over time for the selected Gas ID. It demonstrates the fit of the gas 

reference spectrum to the sample spectrum. 

Spectrum Display  

Displays the raw infrared absorbance spectrum. The dropdown menu on the toolbar provides the user with 

the following spectrum display options:  

• Sample 

• Single Reconstruction 

• Subtraction 

• SBeam 

• IGram 

• Residual 

• Regression Reconstruction 

Diagnostic View 

Diagnostic View is described in detail in Chapter 6 MAX-iR Diagnostics.  
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Display and Plotting Tools 

The following table describes the tools needed to manipulate the displays in Monitor View, Detailed View, and 

Diagnostic View.  The function of each tool is also listed.  

For most of these tools and display options, the plot the user wants to edit must be selected. Select the desired 

plot by clicking on its panel. The actively selected plot will have a blue banner. For example, in the image below, 

the Concentration plot is selected:  
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TABLE 12. GENERAL REFERENCE LIST FOR PLOTTING AND DISPLAY VIEW ICONS 

ICON Description Function 

 
Move Selection Cursor Click to move the Spectrum Selection Slider across Concentration Panel. 

 
Pan View Click and drag on any plot to pan the viewing region. 

 
Drag Zoom 

Click and drag the cursor on any plot to zoom to the selected region. 

Click and drag along the x- or y-axis in the grey area outside of the plot 

to zoom in one direction while the other is held constant. 

 
Zoom In Located in the drop-down menu of the Drag Zoom . Click on the 

screen to zoom in.  

 
Zoom Out 

Located in the drop-down menu of the Drag Zoom . Click on the 

screen to zoom out.  

 
Track Values 

When selected, click & drag across data on any of the plots to display 

more detailed results for each point. 

 
Hide / Show Legend 

Will hide or show the legend for the highlighted / selected display 

panel. 

 
Reset Pan/Zoom Reset the selected plot to full scale. 

 

Set Viewing Area 

Numerically 

Manually enter the display range of the x- or y-axis on the selected 

plot. 

 

Find Sample Spectrum 

Cursor 

Resets the Sample Spectrum Locator (green hashed trace) to the 

center of the viewing region on the concentration plot. 

 

Show All Gases in 

Spectrum View 

Reference spectra for all Gas ID’s will be overlaid on Spectrum Display 

plot. 

 
Detailed Analysis 

Displays concentration plot, R2 analysis, and the FTIR sample spectrum 

and quantification regions for spectroscopists and advanced users. 

 
Concentration Overlay Displays a concentration plot with all gases overlayed. 

 
Data Filter 

Add custom data filters for viewing results based on designated 

parameters.  
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Changing the Displayed Sample Spectrum  

Spectrum Selection Slider is a scroll bar that can be dragged to coarsely scroll through the spectral dataset. It 

can also be fine-tuned using the (+) and (-) buttons to the right of the slider. See the Red boxes below showing 

the slider location for the Monitor and Detailed views. When a new point is added to the active screen the 

locator will go to the end of the dataset.  If you have a rapid running analysis this function will not be useful 

since it will continue to jump to the end.  Considering pausing the data collection if you need to investigate a 

previous spectrum or point. 

 

Sample Spectrum Locator (see the red arrows above) is the hashed green trace on the concentration and R2 

plots. It appears once data has been collected.  Like the Spectrum Selection Slider, this line can be dragged to 

scroll through the dataset. Select the Move Selection Cursor ( ) tool, to drag the green trace to the spectrum 

of choice. The Sample plot displays the spectrum at the same point in time as the green trace. 
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Selecting an Acquisition Method 

If the active Product Configuration is linked to multiple Acquisition Methods, the user can easily switch 

between the available methods any time the devices are Idle. To view the list of available methods, on the top 

toolbar select Edit > Acquisition Method to open the Instrument Method List Editor.  

 

This will open a separate window titled Instrument Method List Editor. 

 

The column on the left lists the name of each available method, and the column on the right lists the Product 

Configuration that each method is linked to.  

Select the method to be run by clicking on its name in the list. The selected method will be highlighted in blue. 

Click the Select button to open the highlighted method.  

The Acquisition Method can also be viewed and selected from Detailed View. On the top toolbar, click View > 

Detailed View. 
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In the Runtime UI panel on the top left of the screen, the active Acquisition Method is listed above the Play 

Button (For Example: “MAX-iR”).  

 

Click the Select button to open the Instrument Method List Editor. 

 

Select the appropriate method from the list as needed.  

 Active Method 
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Additional Features 

The following sections explain the additional features of MAX Acquisition that support operation of the 

instrument and data analysis. 

View Data Table 

On the top toolbar, click View > Show Data Table… to open the data table for an active run.  

 

All raw concentration results for the reported-on gases are tabulated here. The table will update each time a 

new spectrum is acquired. Each spectrum is tabulated with its time stamp and file name.  

 

If the “Track Active Spectrum” box is checked at the bottom of the window, the selected spectrum (highlighted 

in blue) will automatically advance the user to the next data point in the table each time a new one is acquired. 

Unchecking this box will allow the user to toggle through any item listed item in the table without being 

automatically advanced to the most recently collected data point.  

If acquisition is paused, the gas list in Detailed View will reflect the results from scan that is selected from the 

data table. 

Find Spectrum and View Spectrum File Details 

The list of all acquired spectrum in the active data set can be accessed by clicking Edit > Find Spectrum… A 

separate window will open titled “Find Spectrum.” The file name and time stamp of each spectrum in the data 

set are listed here.  
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A spectrum can be searched by file prefix or number using the search dialog box on the top right of the window. 

A count of the total number of spectra in the data set is tabulated above the list.  

To view the spectrum file details, select the desired scan (it will be highlighted in blue) and click the Details… 

button on the bottom right of the window. This will open the raw spectrum and all values associated with the 

spectral file, including resolution, apodization, and laser frequency. 

 

Click close to return to the Find Spectrum window. 

Alternatively, the spectrum file details can be opened by clicking View > Show Spectrum File Details… This will 

display the details of the scan that the hashed green trace is on in the concentration plot.  
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Spanning Data 

The software provides users the option to span concentration results of individual gases. Typically, a gas would 

be spanned based on a direct reading from a certified standard, which is common for certain compliance testing 

applications.  

To apply a span to a gas, on the top toolbar click Edit > Span… to open the Edit Span Data window. 

 

The user has the option of applying a multiplier or offset to the raw concentration reading of each gas. Select 

the gas for spanning by selecting it form the list (it will be highlighted in blue).  

To span a gas based on the average response of a direct reading, the concentration value must be inputted 

into the dialog box below “Actual.” Click the “Set Span” button, and the appropriate multiplier will be applied 

to span the “Reading” to the “Actual” value. 

The table will list the span multipliers and span offsets applied to each component. It will also detail the 

spectrum used to span the gas along with both the raw and spanned results. 

Click “Clear Span” to remove any span multipliers or offsets from the selected gas. 

Click Close to return to the original view.  
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Error Logging 

If an error occurs while MAX Acquisition is open, it will be listed in the Error Log.  

On the top toolbar, click View > Show Error Logging… to open the Error Logging Window.  

 

Any potential errors that impact instrument communications or performance will be listed in this window. In 

the example above, the computer could not connect to the spectrometer.  

The information listed in this window can be filtered by error severity using the dropdown menu on the top 

left. The options are Trace, Debug, Info, Warn, Error, and Fatal.  

 

For more information on error descriptions and troubleshooting, please refer to Chapter 10 (10 

Troubleshooting).  

 
For troubleshooting assistance, please contact Technical Support at 1-800-532-4752. Select “option 2” for Unity 
Lab Services technical support. For instrument type, select “option 6” for Molecular, Vibrational Spectroscopy 
Based Spectrometers. 
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Archiving Data 

The Archive tool in MAX-Acquisition is necessary for periodically saving backups of your acquisition method(s), 

quant method(s), Product Configuration, gas references, and measurement standards. In the event of a 

computer crash or unintentional changes to the data acquisition method, archives can be used to restore 

previous versions. Archived methods can also be crucial for receiving fast support, since they allow replication 

the customer’s system so method edits can be made efficiently while minimizing interruptions to data 

collection.  

Please follow the steps outlined below to archive your data:  

1. Stop or pause data collection.  

 

2. At the top toolbar, select Tools, Archive Data…  

 

3. A separate window will pop up titled “Archive Save Options”  

 

4. Select Browse... and navigate to the desired save directory.  

o Windows File Explorer will open in a separate window. 

o The default save location for archived files is C:\MAX Data\Output\Archives. 

o Enter the desired file name for the saved archive (ex: Combustion Test #1 2022-10-31).  

 

5. Select Save to return to the archive window.  

 

6. Check the boxes so that they match the image below. These options are sufficient for routine backup of 

methods.  
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o For certain support concerns, Error logs may also be required.  

o Specific archive options may be provided by the Technical Support team for certain support 

requests. 

 

7. Select OK to save the archive.  

 

8. Another Windows File Explorer window will open to the save location of the archive.  

o Every archive is saved as a compressed folder (.zip).  

 

9. Select Close and return to the Acquisition window.  

 

10. Press Play to resume data collection once the archive backup is complete.  
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6 MAX-iR Diagnostics 

This chapter explains how to perform routine MAX-iR diagnostic checks to ensure instrument calibration. The 

user must understand the basic software tools to navigate the software and run the diagnostics, so please 

review this information in Chapter 5 MAX-Acquisition Software Overview and Features before starting 

this section.  

 
If the MAX-iR is used for compliance testing, instrument diagnostics must be checked once per day prior to 
any sample data acquisition. See Chapter 8 Recommended Operating Procedures for the 
recommended diagnostics testing frequency. 

 

Diagnostic View 

MAX-Acquisition must be Idle to open Diagnostic View, so click Stop to end a current run if needed. On the top 

toolbar click View > Diagnostic View. All diagnostic tests are performed in this viewing mode. 

There are two important diagnostic panels that demonstrate instrument performance: the Water Band tab and 

the Signal to Noise Ratio (SNR) tab. The water band tab allows the user to confirm that the system resolution 

and the calculated IR frequencies are correct. If either measurement are outside their performance metrics, 

the user is encouraged to pause data collection until both are within their metrics. The SNR tab allows the user 

to confirm that the instrument will have the required signal-to-noise to perform the required measurements 

and that the detector response is linear. 
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TABLE 13. DIAGNOSTIC TEST DESCRIPTIONS 

Test Purpose Sample Inlet Gas 

Water Band 
Allows the user to check the instrument resolution and 
set the laser frequency (these tests are critically 
important for good data quality). 

Ambient air or process gas 

SNR 
Displays the Single Beam spectrum and tabulates the 
SNR in different spectral regions. Also calculates the 
detector linearity. 

 Nitrogen 

 

The Stability tab is utilized to determine the instruments sensitivity to temperature changes and is not required 

for normal instrument operational diagnostics checking. 
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Verify Instrument Settings 

 
As soon as Diagnostic View is opened, verify that the gas cell temperature setpoint is correct. It should be set to 
the same temperature as the sample data collection. Specifically, the temperature setpoint should be the same 
as the selected Acquisition Method. 

If the gas cell temperature setpoint is correct, no action is required. 

If the gas cell is set to the wrong temperature, the reading in the Runtime UI will be highlighted in red. To verify 

or modify the temperature setpoint, click the Settings… button.  

 

A window titled Instrument Settings will open:  

 

Modify the gas cell temperature setpoint if needed. Do not change any other instrument settings. The settings 

in the image above (aside from Cell Temp) are the default settings required to run the diagnostics and should 

not be changed. If these settings are changed, the diagnostic results will be incorrect and invalid. 

If the Cell Temp setpoint was modified, click OK to apply the changes and close the window. If no change was 

made, click Cancel to close the window. 

Optional: If you do not wish to save the spectra collected during the diagnostics, in the Runtime UI check the 

box to Pause Spectrum Collection. 
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Summary of Performance Specifications 

The table below outlines the specifications criteria for each diagnostic check. The following sections 
detail how to check these diagnostics in the software. 

TABLE 14. DIAGNOSTIC PARAMETER SPECIFICATION SUMMARY 

Diagnostic Check Specification 

Signal Intensity (Intensity units) > 0.04 (MAX-iR, DTGS) 

> 2.00 (MAX-iR, StarBoost) 

Detector Linearity (% of Max Signal) < 0.1%  

Track Peak At 3133.068 cm-1 

Peak Location 3133.068 ± 0.02 cm-1 

FWHM 1.04 ± 0.04 cm-1 

Computed Laser Frequency Original Laser Frequency ± 0.08 cm-1 
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Water Band Test 

1.  Select the Water Band tab. 

o Set Track Peak At to 3133.068 cm-1  

 

1. Click Play ( ) to begin the test and collect diagnostics spectra. 

 

2. Sample ambient air or process gas for few seconds to introduce ambient-level moisture into the gas cell. 

o The zero filled sample spectrum (blue line) should be between ~0.1 and 0.4 abs.   

 

3. Check the Peak Location. 

o If the water Peak Location is not 3133.068 ± 0.02 cm-1, click Set Frequency.  This will change 

the laser frequency so that the water line is properly centered at 3133.068 cm-1. 

 

4. Check the Resolution. 

o Observe the FWHM. It should be 1.04 ± 0.04 cm-1.  There is no adjustment to optical 

alignment that will correct the resolution. If it is outside this range, check to see that the 

resolution is set to 1cm-1 and the apodization is set to cosine. If it remains outside this range, 

contact Technical Support (see Contact Information and Technical Support). 

 

5. Check the Laser Frequency. 

o Confirm that the Computed Laser Freq. value and the Original Laser Freq. value are within ± 

0.08 cm-1 of each other. Monitor the Computed Laser Freq. for 5-10 more scans. If the 

Computed Laser Freq. drifts more than ± 0.08 cm-1 from the Original Laser Freq., click Set 

0.1-0.4 abs 
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Frequency again. The water peak location and the laser frequency values are linked and both 

will change when the Set Frequency button is pressed. 

o Monitor the Peak Location, FWHM and Computed Laser Freq. for 5-10 more scans to verify 

the instrument continues to meet the specifications without drifting. 

 

7. Press Stop ( ) to end the run. 

 
Take a screenshot of the Water Band Test results for recordkeeping and as mandatory documentation for 
applications such as compliance testing. 

 

SNR Test 

1. Select the SNR tab. 

 

2. Click Play to begin the test and collect diagnostics spectra. 

 

3. Flow 2-5 LPM nitrogen directly into the Sample Inlet. 

 

4. Check Signal Intensity 

o Record the Max Height of the SBeam spectrum (shown below) and confirm it is within the 

specification for the detector configuration. The Max Height is the highest signal in the 

Single Beam Spectrum.  

▪ The Height % is the current signal height with reference to when the tool was started.  

▪ The Height is the current height of the maximum signal. 
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5. Check Detector Linearity 

o Record the Linearity of the single beam spectrum (shown above) and confirm that is < 0.1%. 

Linearity is the % of signal observed beyond the detector cutoff.  

 

6. Stop the flow of nitrogen to the gas cell.  

 

7. Press Stop ( ) to end the run. 

NOTICE 
If the instrument fails any diagnostic criteria or the laser frequency drifts more than 1.0 cm-1, 

please contact Technical Support (see Contact Information and Technical Support). 

8. Return to Default View to Begin Data Acquisition  

o If the Signal Intensity, Detector Linearity, FWHM (Resolution), and Laser Frequency are all 

within their respective specifications, press the Back button in the top right corner of the 

panel to return to the default view.  

The instrument is now ready to collect sample data. If the laser frequency was set to a new laser frequency, a 

new background spectrum will be required. 
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7  Data Acquisition and Reporting 

This chapter describes the basic steps necessary to acquire data in the MAX-Acquisition software. 

Data Storage 

All spectra data are stored indefinitely on the control PC. 

1. Chose a location for Data Storage 

o Above the Runtime UI, press the Save To… button to open the Save Folder Location window. 

o The default directory for saving dataset folders is C:\MAX Data\Samples.  

o To choose a different directory for saving data, click Browse... and select the desired file path. 

 

 
Spectral data should be saved to the local C:\ drive and not sent directly to a network. This ensures data collection 
is not interrupted by any network communication issues. Data should always be backed up to a secondary 
location by the end user. 

2. Setup Automatic Data Naming Structure (Optional) 

o Check the box next to “Automatically Sequence Folder Names” in the popup panel above.  

▪ This allows the spectral data files to automatically be saved into a new folder daily. 

o Type a Project Name into the text box replacing “Project”. 

▪ In the example to the right, it was “Scrubber Emissions” 

o Select a Naming Pattern from the drop-down menu.  

▪ The recommended naming pattern is “Project+Year-

Mon\Day\#Seq”.  

▪ This organizes daily dataset folders into monthly directories, 

shown in the example to the right.  

o Click OK to return to the main MAX Acquisition interface panel. 
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Data Acquisition  
This section describes how to manually acquire sample data in Detailed View. 

 
If you were provided an automated Acquisition Method with Workflow, check the worksteps programmed in 
the Method before acquiring data. Some steps described need not be performed manually. 

 

1. Begin data collection in Detailed View 

o In the Runtime UI, click Play ( ). The status indicator should say Acquiring ( ). 

 

2. Collect a background spectrum. 

o Flow 2-5 LPM of UHP (N3.0) N2 to the gas cell. 

o In MAX-iR tab, click the “Take Background” button. The button will turn blue while the 

background spectrum is being acquired, and the next acquired spectrum will be used as a 

background to Zero the subsequent data. 

 
A new background is needed whenever a new laser frequency is set. 

 

o Monitor the sample spectrum for any absorbances from contamination (water, CO2, etc.) in 

the gas cell. If sharp peaks are observed in the H2O or CO2 regions that are near > 0.1 abs in 

intensity, continue to purge the gas cell with UHP (N3.0) N2 until the absorbances stabilize. 

Take a new Background. Monitor the next 5-10 scans to ensure there is no longer 

contamination in the gas cell. Representative background spectra of nitrogen gas are shown 

in the figure below providing a guide as to appropriate signal levels. Repeat these steps as 

needed. 

 

DTGS Nitrogen background at 1 cm-1 resolution 
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MCT Nitrogen background using 2 x 8 cm-1 (AutoRef) - note the fine features due to ppm level water 

and optical filter 

 

InAs Nitrogen background using 2 x 8 cm-1 (AutoRef) - note the fine features due to ppm water and 

optical filter 

3. Begin sampling the gases of interest. 

o Flow 2-10L of sample to the gas cell. 

 

4. Monitor the Work Steps in the Workflow (Optional) 

o If you are using an Acquisition Method with Workflow, advance through the steps by using 

the left and right arrow buttons. 

o To view the next or previous work step hover the cursor over the left and right arrow buttons. 

 

5. Stopping data collection 

o Use the Pause button ( ) if you wish to suspend data collection while waiting to collect 

further data within the current folder. 
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o To manually stop acquisition, click the Stop ( ) button. If the acquisition is stopped and the 

data are being sequenced to the next data folder, the current folder will be closed and the 

next one generated. 

o If you are using an Acquisition Method with Workflow, data acquisition may either stop 

automatically or restart the workflow in a new data set once complete. Refer to your 

worksteps.  

o Each time data acquisition is stopped, a Summary Results file (.QTA) file will be saved to the 

folder containing spectral files. If the Data Recorder is included in your Product Configuration, 

a database entry will also be published when acquisition is stopped. 
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Excel Reporting in MAX-Acquisition 

QTA files can be exported to Microsoft Excel. Optionally, the Acquisition Method can be configured to 

automatically generate an Excel report at the conclusion of the Workflow data collection or when the data 

collection is manually terminated. This section describes how to export results to Excel and how to set up 

automated Excel reporting in MAX-Acquisition.  

 

 
The Reporting templates are stored in C:\MAX Data\data\Reports 

 

 
A license for Microsoft Excel is not included with purchase. The software allows exporting the QTA summary 
results to Excel format, but unless you purchase a license for Microsoft Excel, they cannot be opened on the 
control PC. 

 

Manually Export Results to Excel in MAX-Acquisition 

Results can be exported to Excel at any point during a run, if acquisition is paused ( ), and/or at the conclusion 

of the run, when data acquisition is stopped ( ).  

 
Data acquisition must be stopped or paused before proceeding further. 

 

1. In Detailed View, just above the Gas List section, click the Excel ( ) button to setup the summary 

results to export to an Excel reporting template.  

 

2. Click the Save As button in the popup window (see figure to the right). 

o  Choose a file name and location for the exported Excel 

spreadsheet. 

o Click Save to return to the Excel Export Options popup. 

 

3. From the Excel Template drop down menu, select the 

appropriate reporting template.  

 

4. Check the box next to Open after export to automatically view the report after saving (provided you have 

a license for Excel resident on the PC). 

o Click Help (?) in the popup window to see a list of the variables that are exported to Excel. 

 

6. Save and Return to Detailed View. 

o Click OK to save (Cancel to reset) the file  

o If Excel is installed, it will open for viewing the report in Excel format. 
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Setup Automated Excel Reporting in the Acquisition Method 

 
Data acquisition must be stopped before proceeding further. 

 
1. Open the Acquisition Method Editor 

o In the main Max Acquisition software top 

toolbar, click Edit > Acquisition Method to 

open the Acquisition Method List Editor. 

o From the Method List Editor, select the 

Acquisition Method for the application then 

click Edit ( ). 

 

2. Setup Data Acquisition Storage Information 

o In the Acquisition Method Editor, click on the 

Info tab (see figure below) to display current reporting information. 

o Choose the location where the report(s) will be saved: 

▪ The default location is the Spectrum Data Folder, the folder containing the FTIR 

spectra.  

▪ To save reports to an alternative directory, click Select to browse for the desired 

directory. In the example below the folder “C\MAX Data\Daily Reports” was created 

and selected. 

 

3. Setup Reports for Each Dataset Collected 

o Under Run Reports, double click the top slot and select which Report Type you want to run. 

▪ Detail or Summary are two default reports provided. 

▪ The reports can be user modified in Excel and saved under another name in File 

Explorer. 

o Double click on the next open slot to add another Report. 

o Choose up to four reporting templates. 
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o Once the reports and storage location have been configured (see figure below), click OK to 

save the selections or Cancel to clear them, and then return back to the main MAX Acquisition 

panel.  

 
Note that these reporting settings will now be applied to all subsequent datasets collected with the 
Acquisition Method. 
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8 Recommended Operating Procedures 

There are no scheduled parts maintenance for the MAX-iR. Routine calibration checks and instrument 

diagnostics should be used to identify any issues requiring maintenance or repair. These routine assessments 

are required to maintain optimal instrument performance and should only be performed by trained and 

experienced personnel. General specifications are provided below, however these may change depending 

upon the application. 

 

TABLE 16. PERIODIC MAX-IR DIAGNOSTIC CHECKS*** 

FTIR Checks Description Purpose Specification 

Peak Signal 

Intensity 
QUARTERLY: Measurement of peak 
intensity of single beam spectrum 

Demonstrates FTIR has enough signal 
strength to achieve the required MDLs 

See SNR Test 

Detector 

Linearity 

QUARTERLY: Measurement of average 
detector signal in specified spectral region. 
 

Demonstrates the detector response is 
linear with respect to changing energy 
intensity required for constant calibration 

See SNR Test 

Resolution QUARTERLY: Measurement of the FWHM 
of a specific Water Band. 

Demonstrate that the FTIR peak resolution 
is still within specifications. 

See Water Band Test 

Laser 

Frequency 

QUARTERLY: Verify that the laser 
frequency is still within the permitted 
values. 

This allows for good spectral matching. See Water Band Test 

Clean Gas Cell 
YEARLY: If Peak Signal Intensity is low then 
clean gas cell and mirrors. 

Removes any film or debris from the 
mirror and window surfaces which 
impacts the amount of light allowed to get 
to the detector. 

See  
MAX-iR Gas Cell 

Maintenance Procedures 

*** Diagnostic checks must be done daily if using the MAX-iR for compliance testing. 

Calibration Checks 

After initial installation, the performance of the MAX-iR should be assessed using a certified gas cylinder as a 

calibration transfer standard (CTS). The CTS is analyzed to verify the MAX-iR response.  

The measured value, an average of 10 independent scans, should be within ±5% of the certified cylinder value. 

No span value should ever be applied to the CTS calibration. A method can be configured to alarm if the 

measurement of the calibration cylinder is outside of this specification when running a CTS. 

For calibration gas and CTS gas component recommendations, please contact Technical Support (see Contact 

Information and Technical Support for details).  

TABLE 15. DAILY MAX-IR PERFORMANCE CHECKS 

Daily Checks Description Purpose Specification 

Zero 

Background 

Direct measurement of UHP (N3.0) N2. 
Repeat daily or whenever new laser 

frequency is set. 

Collect background. For StarBoost 
configurations, collect filter interference 
spectrum.  

Check that the sample 
spectrum has no negative 
absorbances to ensure no 
contamination.  

Alarm Status Monitor the status of all alarms daily. 
Demonstrates the Hardware is working 
properly. All alarms green  
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9 MAX-iR Preventive Maintenance 

This chapter provides a guide to the hardware preventative maintenance procedures for the MAX-iR FTIR Gas 

Analyzer. Preventative maintenance is required to maintain optimal instrument performance, and these 

procedures should only be performed by trained and experienced personnel. While many of these items can 

be completed by the user, it is recommended the user take advantage of the MAX-Advantage support program.  

Preventative Maintenance Schedule 

TABLE 17. PREVENTIVE MAINTENANCE SCHEDULE 

Schedule Procedure Specification 

Quarterly Check MAX-iR Peak Signal Intensity See SNR Test 

 Check MAX-iR Detector Linearity See SNR Test 

 Check MAX-iR Resolution See Water Band Test 

 Check MAX-iR Laser Frequency See Water Band Test 

Annually Clean MAX-iR Gas Cell Mirrors and Replace O-rings See  

MAX-iR Gas Cell Maintenance 

Procedures 

 

  



 

  Page 66 

 

Spare Parts and Consumables 

The following serviceable items are consumables and are not covered under warranty. The user should 

maintain an on-site inventory of consumables, as shown in the table below. 

TABLE 18. MAX-IR CONSUMABLES 

Description 
Yearly 

Qty 
Replacement Interval 

Kit, MAX-iR Gas Cell o-Rings 1 Replace when cleaning gas cell mirrors. 

MAX-iR Gas Cell Windows* 

o KBr Gas Cell Window, MgF2 Coated 

o CaF2 Gas Cell Window 

o ZnSe Gas Cell Window, AR Coated 

o ZnSe Gas Cell Window 

o BaF2 Gas Cell Window 

2  

Remove and replace when cleaning gas cell mirrors. 

Do not remove when cleaning. Replace if damaged. 

Do not remove when cleaning. Replace if damaged. 

Do not remove when cleaning. Replace if damaged. 

Do not remove when cleaning. Replace if damaged. 

MAX-iR Gas Cell Window o-Ring 2 Replace with gas cell window. 

MAX-iR Gas Cell Window PTFE Washer 2 Replace if original is lost or damaged. 

*Application dependent. Refer to MAX-iR Part Numbers and Configurations for details. 

Thermo Fisher Scientific maintains a spare parts depot in East Windsor, CT. For critical spare parts with 

extended delivery times (denoted below), the user should consider maintaining spare parts on-site to minimize 

downtime. 

TABLE 19. MAX-IR CRITICAL SPARE PARTS 

Description 
Yearly 

Qty 
Replacement Interval 

Pressure Transducer* 

o Kit, 1atm Pressure Transducer 

o Kit, 5atm Pressure Transducer 

1 Critical spare. Only replace if needed. 

Kit, Gas Cell Mirror, Objective 1 Critical spare. Only replace if needed. 

Kit, Gas Cell Mirror, Field 1 Critical spare. Only replace if needed. 

*Application dependent. Refer to MAX-iR Part Numbers and Configurations for details. 
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MAX-iR Gas Cell Maintenance Procedures 

Required Tools 

In general, the mirror and windows do not need to be cleaned or replaced unless there are issues with signal 

intensity that cannot be attributed to any other component. 

 

Parts / Tool Description 

Screwdriver Philips head 

Allen Wrenches 2.5mm, 3mm, 4mm 

Long Shaft Allen Wrench 5mm 

Lens paper 
Lint free lens paper or lens cloth – do not use 

Kleenex or paper towels 

Water & Soap Warm Tap Water & Dawn Dish Soap 

Small flashlight Used to inspect the gas cell windows 

Gas Cell Mirror o-Ring Kit MAX-iR Gas Cell O-ring – Qty 1 

 

 
Take care when working with the gas cell and the sample line as they may still be hot. Allow at least 4 
hours for cooling before handling the gas cell or sample lines. 
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Removing the MAX-iR Gas Cell 

Using the Phillips head screwdriver remove the 6 outer screws of the MAX-iR top cover – two on each side and 

two on the top back flap of the cover. 

o Using the 3mm Allen wrench loosen (do not remove) the two screws holding the gas cell cover 

on and pull the cover up and off the gas cell. 

 

 

o Facing the back of the MAX-iR, note the orientation of the bulkhead shields. Use the 2.5mm 

Allen wrench to remove two lower screws as well as the two upper screws holding the 

bulkhead shield in place. Remove the shields and set them aside. 

o Using a Phillips head screwdriver, remove the 4 screws holding the Sample In/Sample Out 

access panel in place. Remove the access panel and set it aside. 

 

o Disconnect the electrical connections going to the gas cell. There are two yellow 

thermocouple connections and two white Molex power connections that are adjacent to the 

pressure transducer that need to be removed. 

o The yellow connections are removed by squeezing the sides and gently pulling them out. 

o The white connectors are removed by pushing down on the top clip and gently pulling them 

out. 

o Using the long-handled 5mm Allen wrench, loosen the 4 capture screws - two on each side of 

the gas cell base - that are holding the gas cell in place. Pull the gas cell up – note you may 
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have to use a flat head screwdriver in the specified notches to gently pry the base up to loosen 

it. 

 

 

 

o Carefully remove the gas cell from the MAX-iR by pulling the left side (with the window 

retainers) towards the outside first, so the window retainers come out first. 

Replacing the MAX-iR Gas Cell Windows 
 

1. Inspect the Windows for fogging 

o Without removing the windows, use the flashlight and shine it on the gas cell windows to see 

if there is any fogging. 

o If the windows are clean, proceed to next section to replace or clean the MAX-iR gas cell.  

 

2. Replace the Windows and Window O-rings 

o Use the figure below for reference. For ease of window replacement, it is recommended that 

the field mirror (mirror with windows) be removed before replacement of the windows. Refer 

to the next section for the proper procedure to remove the mirror. 

o Gently remove the grey insulation from the window retainers, pulling the top above the top 

window retainer. Be careful not to tear the insulation. 

o Remove and set aside the two outer O-rings on the outside of the two window retainers (A). 

o Using the 3mm Allen wrench remove each of the three window retainer screws and remove 

the retainers (B). 

o Remove the white PTFE gasket (this will be reused so do not throw it away). 

o Remove the window and the bottom O-ring out of the gas cell cavities (C, D). The windows 

may be stuck and require some force to remove.  Put the mirror face down on a flat surface 

with a cloth and gently push the windows out using a Q-tip from the other side. It may require 

pressure around the corners of the window for it to be removed. (Damage to the window is 

common when removing them, only remove them if necessary or if they are being replaced).  
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o Make sure the O-ring groove is clean and dry (a Q-tip) is ideal for cleaning, drying or removing 

debris  

o Insert a new O-ring (D) and new window (C) into the gas cell cavity (red arrow). 

o Only 5 mm thick by 25 mm to 25.2 mm diameter round windows can be utilized by MAX-iR. 

o The best procedure to insert a new window is to hold it above the opening and then drop it 

onto the O-ring.  Trying to place the window in the opening may cause it to cock and this can 

crack the window.  If the window goes in at an angle do not try to push into place (this will 

cause damage to the window). Gently flip the mirror over and catch the window with a gloved 

hand or onto a soft cloth on a flat surface. 

o Reinsert the PTFE gasket on top of the window. 

▪ Note: The white PTFE gasket located between the retainer (B) and window (C) should 

only be replaced if it is damaged (see below). 

 
o Replace the retainer (B) and then gently tighten down the retainer with the three screws in a 

circular pattern until all three screws are completely tight.– repeat for the other window. 

o Replace the outer sealing O-rings (A). 

o Confirm that the insulation is on the window retainers and the inlet / outlet plumbing on the 

rear of the gas cell before attempting to reinstall the gas cell.  Be gentle it can tear easily. 
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3. Replace the Gas Cell back into the MAX-iR 

o To replace the gas cell into the MAX-iR, follow the reverse instructions as shown in the section 

above Removing the MAX-iR Gas Cell. 

o The gas cell is positioned properly if it is firm in place and does not rock side to side. Gently 

tighten the four captive baseplate screws until completely tight to the baseplate. 

o Confirm that the remaining insulation is in place. Especially the two pieces located underneath 

the mirrors on both ends. 

o Replace the insulating cover making sure the foam does not tear or fold over. 

o Tighten 3 mm screws to hold the cover in place 

o Make sure the cover slips all the way down against the optics box cover and that it is not 

standing off of the back plate (should be a ¼ inch below the vertical back plate). 

o Reconnect the 4 electrical connections, starting with the two white Molex connections and 

then the two yellow thermocouple connections. 

o Replace the back plate of the MAX-iR that includes the plumbing bulkhead shields. 

 
Before reinstalling the gas cell, verify that all 12 heater plate screws on the top and bottom are tight. 
Failure to do so may result in poor heating and / or damage to the heaters. 
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Replacing or Cleaning MAX-iR Gas Cell Mirrors 

 
In most cases, cleaning the Objective Mirror (F) should be sufficient. Only clean the Field Mirror (C) if 
necessary. 

 

1. Remove the Gas Cell from the MAX-iR 

o Follow the same instructions as shown in the section above Removing the MAX-iR Gas Cell. 

 

2. Remove the Gas Cell Mirrors 

o Use the figure below for guidance. 

o Remove and set aside the two outer O-rings on the outside of the two window retainers (A). 

o Using the 2.5mm Allen screwdriver, loosen the six screws holding each of the heater plates to 

the gas cell (green circles). Do not remove. 

o Using the 4mm Allen screwdriver, remove the three screws (B) holding the Field Mirror (if 

needed) (C) and Objective Mirror (F) to the gas cell body. 

o Pull both mirrors off the gas cell body and remove the two O-rings (D, E). 

 
Take care that you put the correct O-rings back on the gas cell as they are different sizes. D is the Field Mirror 
O-ring while E is the Objective Mirror O-ring. 
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In the next step below you must use lint free lens paper or lens cloth – do not use Kleenex or paper towels 
or you will permanently scratch the surface of the mirrors. 

 
3. Clean the mirror surface 

o Inspect the mirror surfaces for contamination. 

o Wearing Latex lab gloves to hold the sides of the mirror, use warm tap water (distilled will not 

work well) to gently rinse the surface of the objective mirror over a sink or appropriate waste 

disposal area.  

o If a residue remains on the objective mirror surface, Dawn Dish Soap can be utilized to clean 

the mirror surface. 

▪ Apply a small drop of Dawn dish soap to the mirror surface. Very gently, a gloved 

finger can be used to spread the soap across the mirror surface, until the soap suds 

fully 

▪ Use warm tap water to thoroughly rinse the mirror surface and remove all soap. 

o Rinse mirror with distilled water (if available). 

o  Dry the mirror with high pressure N2 or clean dry air (CDA), to remove all visible traces of 

water. Then inspect again for any contamination. Clean again if needed; if residue still 

remains, use a lint free lens paper or cloth (diagrammed 

Make sure the entire mirror is completely dry prior to returning it to the gas cell. 

 
4. Reassemble the gas cell 

o Replace both the Objective and Filed mirror O-rings with new ones. 

o Use the figure and instructions above in Step #2 of Replacing or Cleaning MAX-iR Gas Cell 

Mirrors and reverse the order to reassemble the mirrors onto the gas cell. 

o The mirrors should be tightened until the screws stop turning. If the screw has a gummy 

feeling while tightening, it is possible the O-ring is trapped outside its intended groove.  If 

this happens it is recommended to replace the trapped O-ring with yet another new O-ring 

for proper sealing. 

 

5. Replace the Gas Cell back into the MAX-iR 

o To replace the gas cell into the MAX-iR follow the reverse instructions as shown in the section 

above Removing the MAX-iR Gas Cell. 

 
Before reinstalling the gas cell, verify that all 12 heater plate screws on the top and bottom are tight. Failure 
to do so may result in poor heating and / or damage to the heaters 
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Replacing Fuses 

The power inlet module has two fuses to protect against overcurrent or short circuit.  If necessary, be sure to 

replace with fuses of the same rating, as indicated on the system label.   

1. Shut off the power to the MAX-iR 

o Switch the Power switch on the back of the unit to OFF. 

o Disconnect the system power cord from the back of the unit. 

 

2. Remove the fuse block from the power inlet module 

o Use a flat head screwdriver to pull the block out. 

 

 

3. Replace both fuses and insert the power inlet module back into the unit. 

Plug in the cord, switch on the power switch to turn the power back on to the unit.  
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10 Troubleshooting 
This chapter provides guidelines to frequently asked questions relative to troubleshooting the MAX-iR and 

associated software.  

 

Issue Solution 

No communication with 

Temperature or Pressure 

sensor after software 

installation 

Disconnect USB from computer or MAX-iR and reinstall software. 

The computer went to sleep 

which disrupted data collection 

and caused a connectivity issue 

1. Install the updated software version (if applicable) 

2. Go to Start > Settings > Power & Sleep. 

3. For both sleep options, please select "Never". 

4. Power off the MAX-iR. 

5. Go to Start > Power > Restart. 

6. Once the computer has restarted, power on the MAX-iR. 

Software not acquiring 

temperature and/or pressure 

1. Verify that the serial USB connection cable is connected between the 

MAX-iR and the computer.  

2. In the MAX-Acquisition Software, go to Edit > Product Configuration. 

Select the current Product Configuration so it is highlighted in blue, then 

select the pencil icon to edit it.  

3. Once the editing window opens, select the MAX-iR Temperature and 

Pressure Sensor module. Next to COM Port, click Search to allow the 

software to automatically identify the appropriate COM port.  

4. If the software identifies a COM port, select OK then Save the changes to 

the Product Configuration before resuming data collection.  

5. If a COM port is not identified, unplug the ethernet cable as well as the 

serial USB connection from the PC. Re-connect the ethernet and serial 

cables.  

6. Retry the search. Once identified, select OK then Save the changes to the 

Product Configuration before resuming data collection. 
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Software not connecting to 

spectrometer 

1. Verify that the ethernet cable is connected between the MAX-iR and the 

computer.  

2. In the MAX-Acquisition Software, go to Edit > Product Configuration. 

Select the current Product Configuration so it is highlighted in blue, then 

select the pencil icon to edit it.  

3. Once the editing window opens, select the MAX-iR Spectrometer module 

Next to Spectrometer Instance, click Search to allow the software to 

automatically identify the appropriate spectrometer.  

4. If the software identifies a spectrometer, it may give a message indicating 

that the laser frequency may need to be set. Typically, this occurs when 

it is the first time that the computer is connected to the hardware.  

5. Select OK then Save the changes to the Product Configuration before 

resuming data collection.  

6. If a spectrometer is not identified, unplug the ethernet cable from both 

the MAX-iR and PC. Re-connect the ethernet cable to both the MAX-iR 

and computer. Retry the search. Once identified, select OK then Save the 

changes to the Product Configuration before resuming data collection. 

Gas cell not heating 
Check the power connections and the thermocouple connections under the 

top cover (next to the pressure transducer) 

No Water Band during 

Diagnostics 

Add ambient air to the gas cell. This should contain enough water to allow for 

proper calculation of the laser frequency and water band frequency. 

Poor laser frequency 

calculation  

Confirm that the water peak is between ~0.1 to 0.4 abs for best calculation of 

water and laser frequencies.  If the water absorbance is too low, add ambient 

air to the gas cell.  If the water absorbance is too high, turn on N2 briefly to 

the gas cell and then stop the flow, so that the moisture is between the 

recommended absorbances. 

Calculated laser frequency 

outside of standard range 

Laser frequency is more than ±2 cm-1 from 15799 cm-1.  Confirm that the water 

peak is between ~0.1 and 0.4 abs. 

If still outside of range, please contact Technical Support for instructions on 

how reset to proper laser frequency (see Contact Information and Technical 

Support). 

FWHM of Water Band 

If FWHM is outside recommended guidance, confirm that the water band is 

between ~0.1 and 0.4 absorbance and measure again. 

If the FWHM is significantly higher than 1.04 cm-1, check resolution setting of 

instrument. Then check the gas cell windows for fogging. 

If the gas cell was recently removed, confirm gas cell is properly seated. 

Gas Cell Temperature 

Incorrect in Diagnostics 

The gas cell temperature is set in the Acquisition Method. It is recommended 

that diagnostics are run at the same temperature that data will be collected. 

Select the Acquisition Method that corresponds with the data collection prior 

to running diagnostics. This will ensure the diagnostics are run at the correct 

temperature.  
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CTS Failed 

1. Verify that the gas cylinder is properly connected and that there are no 

leaks.  

2. Confirm that the ethylene calibration in the Quant Method matches the 

temperature, pressure, and resolution settings in the Acquisition 

Method.  

3. Check MAX-iR Diagnostics (see Water Band Test and SNR Test). 

4. Repeat CTS measurement. 

Quant is ‘NaN’ 

Confirm the quantification region is in a region of the spectrum that there is 

signal present, and that the absorbance spectrum is being calculated for that 

region.  If not, the quantification region must be moved to a valid region.  

Algebraic values not displayed 
If the algebraic is a batch average over a particular Workstep, the value will 

not publish until that workstep is complete. 

Low Signal Strength 

If the MAX-iR is used to analyze process or environmental samples, the gas 

cell may be contaminated.  Consider cleaning the Objective mirror and/or 

replacing the windows if they are damaged. See MAX-iR Gas Cell 

Maintenance Procedures. 

Signal Strength Alarm 

If the signal is below 10, consider increasing the gain.  If the signal is above 90, 

it is important the gain setting be reduced to prevent over-range of the 

digitizer. This will produce poor data quality like wavy baselines and single 

beam spectra. 

Desired Acquisition Method 

does not appear in list 
Verify that the correct Product Configuration is selected.  

Error Message: Setting 

Resolution: 1 
The resolution did not set properly. Close MAX-Acquisition then re-open it. 

Error Message: X Hours Since 

Last Neon Calibration 
Contact Technical Support (see Contact Information and Technical Support). 

Pressure Transducer does not 

agree with calibrated 

Baratron measurement 

The pressure transducer in the MAX-iR comes calibrated and should not 

require any adjustments. If it is suspected that the pressure transducer is not 

measuring correctly, please contact Technical Support (see Contact 

Information and Technical Support). 
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Poor Spectral Residuals or 

quantitative results 

1. Confirm the laser frequency is correct. 

2. Confirm the resolution is correct for the method being used. 

3. Confirm that all gases present in the sample are in the method. 

4. Confirm that water and carbon dioxide are listed as interferences. 

5. Confirm the quant region is within the spectral range of the system. 

6. Confirm that multiple regions are not being utiilized by reviewing the 

location of the residual. 

7. Confirm the calibration and sample gas are at the same temperature. 

8. If all settings are correct, try utilizing the fencing algorithm within the 

calibration editor to reduce the residuals. 

9. Additionally try using “Forward” only in the MAX-iR settings instead of 

“Both” 

MAX Software needs to be 

installed 

Whenever the MAX Software package needs to be installed, the license key 

needs to be active on the associated computer and all MAX software 

programs must be closed. If updating the software, do NOT uninstall the 

previous software version or it will result in permanent loss of data, 

calibrations, methods, etc. 

Quant Method was modified 
If the Quant Method is modified, the updates can be saved by selecting File > 

Save Quant Method As… 

Instrument Method is in Read 

Only 

To modify the Instrument Method, data collection must be stopped. If data 

collection is active or paused, the software will display the Instrument Method 

editor in Read Only view to prevent modifications. 

A Bad Scan occurred 

If the MAX-iR experiences any sudden contact, such as getting bumped into, 

hit, etc. a bad scan may occur. It is best practice to set up all sample lines prior 

to data collection and to take care to avoid harsh contact with the MAX-iR. 

Low Signal Alarm Forward/backward sweep – need additional info 

Computer crashed and 

software is not working 

It is recommended that data, Instrument Methods, and Quant Methods are 

backed up in case of a computer crash. If the computer crashes and the MAX 

Software package is not responding, update and restart the computer. If the 

issue persists, re-install the MAX Software package. 

While the MAX-iR was open, 

the Watlow was manually 

adjusted 

All the Watlow settings in the MAX-iR are preconfigured so that the MAX 

Software package controls all temperature settings in the MAX-iR. Therefore, 

it is recommended that the Watlow is never modified or adjusted manually. If 

the Watlow settings are modified or adjusted, they will need to be reset back 

to factory settings. If this occurs, please contact Technical Support (see 

Contact Information and Technical Support). 
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Liquid moisture may have 

gotten into the gas cell 

If KBr with MgF2 windows are in use, the windows may become fogged or 

even dissolve in the presence of liquid moisture. This will likely result in loss 

of signal that cannot be attributed to another factor.  

If any of the alternative windows are used, the gas cell will likely need to be 

heated to 191C and purged with N2 to remove the moisture. Alternatively, 

the gas cell can be cleaned as well. 

If you are unsure of the type of windows that you have in your MAX-iR, please 

contact Technical Support (see Contact Information and Technical Support).  

Gas cell window will not 

remove from the mirror 

It is important to note that the gas cell windows can easily get damaged or 

broken when removed. As a result, it is recommended that spare windows are 

kept on hand. Windows are easier to remove when they are warm, but the 

gas cell should never be hot during maintenance, or it could result in injury. 

A trick that can be utilized to help remove the window is to use a clean, dry q 

tip to gently push along the outer edge of the window to help push the 

window out. Do NOT touch anywhere near the center of the window or it 

could result in damage to the window. 

When replacing the gas cell 

window, the window keeps 

going in place crooked 

It is important to ensure that the window o-ring is replaced when the window 

is replaced. The washer should only be replaced if it is damaged or deformed. 

When replacing the gas cell window, it is important to keep the window level 

over the hole in the mirror with the mirror laying flat. The best means of 

setting the window into place is by “dropping” it. 

Gas cell mirror was cleaned, 

but there is still residue on 

the mirror 

Always follow the steps outlined in Replacing or Cleaning MAX-iR Gas Cell 

Mirrors. If the gas cell mirror still has a residue after , contact Technical 

Support (see Contact Information and Technical Support). 

Retainer plates around the 

Sample In and Sample Out 

were removed 

There are 2 metal retainer plates that are located around the Sample In port 

as well as 2 that are located around the Sample Out port. For MAX-iR 

maintenance, they may need to be removed. When putting them back into 

place, they should be installed so that there is not a gap between the red 

insulation ring and the retainer plates. Take care not to damage the red 

insulation ring during this process to avoid creating a cold spot. 

The foam insulation was 

damaged during MAX-iR 

maintenance 

The insulation material is brittle and can easily be damaged or broken. It is 

important to take special care of it while working on the MAX-iR. If the 

insulation material becomes damaged at any time, please contact your sales 

representative to order a replacement. 

Error Message States “No 

connection could be made 

because the target machine 

actively refused it. 

127.0.0.1:5002” 

If this error message appears when connecting to the spectrometer, it 

typically indicates a part of the MAX Software package was not installed 

properly or has been deleted. Close all MAX Software programs and re-install 

the MAX Software. If this becomes a recurring issue, contact Technical 

Support (see Contact Information and Technical Support). 
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Appendix: O-ring Chemical Compatibility 
Gas (as bulk) Viton FFKM (Kalrez) PTFE (Teflon) 

Ammonia U S S 

Hydrogen Chloride S S S 

Hydrogen Bromide S S S 

Hydrogen Fluoride S S- S 

Phosphine N/A S S 

Diborane N/A S S 

Arsine S S S 

Silane S S S 

Trichlorosilane N/A S S 

Boron Trifluoride N/A S S 

Nitrogen Trifluoride N/A S S 

Carbon Tetrafluoride S S S 

Sulfur Hexafluoride S S S 

Phosgene N/A S S 

Hydrogen Cyanide S S S 

Carbonyl Fluoride N/A S S 

Fluorine S- S- U 

Bromine S S S 

Hydrogen S S S 

Argon S S S 

Oxygen U S S 

Nitrogen S S S 

Carbon Dioxide S S S 

Carbon Monoxide S S S 

Methane S- S S 

Ethane S S S 

Ethylene S S S 

Propylene S S S 

Propane S S S 

Ethylene Oxide U S S 

Ozone S S S 

S (satisfactory)    

S- (slightly satisfactory)   

U (unsatisfactory)    

N/A (no available data)   
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